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1 Introduction

This primer givesyou a quick startin usingthe new Sun Fire SMP-Clusterat the
AachenUniversity. It describeshe hardwarearchitectureselectedaspect®of the op-
eratingenvironmenta few softwaretools, and helpful referencegor further infor-
mation. The software tools include:

« TheSun ONE Studio 8 Development Tools [YF

* Sun HPC ClusterTools Version 5.0, Sun’s MPI implementationand environ
ment now fully supports MPI version [J3lj

 TotalView Version 6.1, Etnus’ latestparallel debuggernversionnow supports
Sun'slatestcompilersand the debuggingof programsusing the 64 bit addressing
mode.DebuggingMPI programshasalsobeenconsiderablymprovedwith theHPC
ClusterToolsVersion5.0. Debuggingof OpenMPprogramss possiblein combina
tion with the KAP/Pro Toolset's Guide compild3l

*  VampirTrace Version 3.0 andVampir Version 3.0, Pallas’tools for runtime
analysisof MPI programswork well with HPC ClusterToolsVersion5.0. (MPI2 is
not yet fully supported [Nl

* KAP/Pro Toolset Version 4.0, KA OpenMP tools including
* the KCC C++ Compiler Version 4.0 which is part of the KAP/Pro Toolset

* somedetailsaboutthe Solaris 9 operatingsysten (It will successivelybe in-
stalledon all the SunFire systemsand particularly effectsthe runtime behaviourof
the Sun Fire 15 K systen[3lL)

Site-specific sections are marked WIILL.

Pleasecheckour web pagedor moreup-to-datanformationandthe latestversionof
this document:

http://www.r z.rwth-aachen.de/hpc/
http://www.r z.rwth-aachen.de/computing/info/sun/primer/

For interactive access to the cluster, login to
cluster-sun.rz.RWTH-Aachen.DE

Pleasgoin ther zcl ust er mailinglist, if youwantto beinformedon aregularba
sis:

http://MailMan.RWTH-Aachen.DE/mailman/listinfo/r zcluster
Do not hesitate to send criticisms or suggestions to

hpc@r z.rwth-aachen.de
Have fun using the new Sun Fire SMP-Cluster!
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2 Hardware

2.1 Configuration
The Sun SMP-Cluster currently consists of

16 Sun Fire 6800 nodes with 24 UltraSPARC-11I Cu processors and 24 GB of
shared memory each and of

4 Sun Fire 15K nodes with 72 UltraSPARC-II1 Cu processors and 144 GB of
shared memory each.

All 672 CPUs have a 900 MHz clock cycles with an accumulated peak performance
of 1,2 TFlop/s and atotal main memory capacity of 906 GB.

All compute nodes are equipped with local scratch (TMP) and system file systems.
They also have access to a common NFS file system for small long-term user data
(HOVE) and to another common file system for large medium-term work files
(VWORK).

In the future al compute nodes will have direct access to all shared filesystems viaa
fast storage area network (SAN) using the QFS file system. High 10 bandwidth will
be achieved by striping multiple RAID systems.

All SMP compute nodes are connected to each other by Gigabit Ethernet. In 1Q2003
the proprietary high-speed Sun Fire Link networks have been installed to form two
clusters of 8 Sun Fire 6800 systems each. The Sun Fire Link connection between the
4 Sun Fire 15K systems is planned for 2Q2003.

Finally all nodes will be upgraded with UltraSPARC-1V processors in 4Q2003.

date  |nodes processors main memory |[networks
2Q2001 |8 Sun Fire 68008 x 24 US-I11 750 8x24GB GE, Myr
4Q2001 |8 Sun Fire 6800 (8 x 24 US-111 750 8x24GB GE, Myr
8 Sun Fire 6800 |8 x 24 US-111 900 8x24GB GE
1H2002 |8 Sun Fire 6800 |8 x 24 US-111 900 8x24GB GE
8 Sun Fire 6800 |8 x 24 US-111 900 8x24GB GE
4 Sun Fire 15K |4 x 72 US-111 900 4x 144 GB GE
1H2003 |8 Sun Fire 6800(8 x 24 US-111 900 8x24GB GE,FireLink
8 Sun Fire 6800 |8 x 24 US-111 900 8x24GB GE,FireLink
4 Sun Fire 15K |4 x 72 US-111 900 4x 144 GB GE
40Q2003 |8 Sun Fire 6800 (8 x 24 US-1V 1500 |8 x 24 GB GE,FireLink
8 Sun Fire 68008 x 24 US-1V 1500 [8x 24 GB GE,FireLink
4 SunFire15K [4x 72US1V 1500 |4 x 144 GB GE,FireLink
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2.2 Processors

The UltraSPARC-111 Cu processor (US-111 Cu) is asuperscalar 64-bit processor with
two cache levels:

Level 1 (on chip):

64 KB for data and 32 KB for instructions

(4-way associative, 32 byte cache-lines, write-through, no-write allocate, pseudo random
replacement strategy, 2 clock cycles latency. Modified cache lines are written back
immediately into the L2 cache and a cache line is not fetched before a write operation)

2 KB prefetch cache, for an accelerated load of floating point numbers
(4-way associative, 64 byte cache lines, 32 byte subblocks, LRU replacement strategy)

2 KB write cache
(4-way associative, 64 byte cache lines, 32 byte subblocks, LRU replacement strategy)

Level 2 (off chip):

8 MB for data and instructions

(2-way associative (900 MHz), 512 Byte cache lines with 64 byte subblocks, approx. 12
clock cycles latency, 6.4 GB/s bandwidth, write-back; write-allocate strategy. Modified
cache lines are not written back until they are pushed out of the cache and before a write the
whole subblock has to be fetched from memory.)

[cﬁ;:m “ g FPU W$ = write cache
T T FPU = fl. point unit
¢ WS = write cache

D$ = data cache (L.1)

w D
$ —» D% P$ P$ = prefetch cache

T T X$ = external cache (L2)

I I
6.4 4 v2.4 Mem = memory
X$ Mem

The most important information about the current processors can be acquired with
the instruction

$ fpversion

Each clock period the processor can initiate 2 integer operations or an integer and a
memory operation, one floating point addition and one floating point multiplication.
Thus the peak performance in Mflop/s is twice the clock rate in MHz. In suitable
computing kernels, like the well-known Linpack benchmark or a matrix multiplica
tion, 70-90% of this rate will be actually attainable.
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2.3 Memory
Each CPU board contains 4 processors and their external (L2) caches together with
their local interleaved memory.

In the Sun Fire 6800, 6 of these boards are coupled with a crossbar. The memory
bandwidth amounts to theoretically 2.4 GB/s for a single processor and -- due to
snoop bus limitations -- 9.6 GB/s for all 24 processors of a SMP node.

In the Sun Fire 15K, 18 CPU boards are interconnected with a crossbar and the
cache coherency is handled by a combination of snooping within each board and di-
rectory-based cache coherency between the boards.

From the programmer’s point of view, the Fire 6800 thereby offersa™ flat " memory
system with a limited bandwidth (9.6 GB/s), i.e. al memory cells approximately
have the same distance to each processor (latency about 270 ns), whereas data local-
ity plays amore important role in the Fire 15K (cc-NUMA architecture).

The latency to get data from memory on the same board is approximately 270 ns.
The Fire 15K’ s latency for fetching remote data will be at least 330 ns and in ex-
treme cases, however, up to about 600 ns. Theoretically the total memory bandwidth
will be between 43.2 GB/s (worst case) and 172.8 GB/s (only local accesses). Data
locality will be supported by the upcoming version of the Solaris 9 operating system.

CPU Board 74

VL—'D Mem

» 3x3 AUS—IUCu

——w 3x3 |le=—» US-IIICu

Mem

FirePlane [, | | 343

2.4

2.4
Crossbar 4.8 o 2 4 .

2.4,

—» 3x3 US-III Cu

L 3x3 WUS—IHCu

T—» Mem

24
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2.4 Networ k

Gigabit Ethernet is used to interconnect SMP nodes. Furthermore, two tightly cou-
pled clusters of 8 Fire 6800 systems each have been formed and one cluster of 4 Fire
15K systems will be formed in the near future with proprietary high-speed Sun Fire
Link networks. With Sun’s version of MPI, a latency of 4 micro seconds and a band-
width of about 2 GB/s can be obtained between 2 nodes compared to alatency of at
least 100 us and a maximum bandwidth of about 100 MB/s when using the Gigabit
Ethernet. It takes at least 8 simultaneous transfers to saturate the Fire Link connec-
tion between two nodes. [[3l
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3Operating System

The Solaris Operating Environment is an operating system of the UNIX family.

The current version on about half of the Sun Fire machinesis Solaris 8, and Solaris 9
on the other half. We will completely migrate to Solaris 9 soon.

The command
$ unane -r
will print out the corresponding SunOS release level 5.8 or 5.9.

Solaris 9 will introduce the multiple page size support and the memory place-
ment option (MPO) which is particularly important for the Sun Fire 15K systems.

By default Solaris organizes all data in pages of 8 KB. Programs with a large mem-
ory requirement and/or programs which access memory randomly or with non-unit
strides might profit from using a large page size (reduction of TLB misses). This can
be done by using the ppgsz command. Example:

$ man ppgsz # manual page
$ ppgsz -o heap=4M st ack=4M a.out # program start

As an dternative environment variables can be used:

$ LD PRELOAD=npss. so. 1 MPSSHEAP=4M \
MPSSSTACK=4M  a. out

A new command-line option, - xpagesi ze, enables the running program to set the
preferred stack and heap page size at program startup (Studio 8 compilers). For ex-
ample, - xpagesi ze=4N sets the preferred Solaris 9 operating environment stack
and heap page sizes to 4 megabytes. Choose from a set of preset values. Stack or
heap page sizes can be set individually with - xpagesi ze_st ack and - xpage-

si ze_heap. (Note that this feature is not available on Solaris 7 and Solaris 8 envi-
ronments. A program compiled with this flag will fail to link these environments.)
See the 95 man page for details.

All dynamically or locally allocated data, as well as uninitialized Fortran COMMON
Blockswill be allocated on large pages (4 MB in the above example), if enough con-
secutive memory is available. You may check the running program with the com-
mand (Solaris 9)

$ pmap -s pid # address space map of a process

The Sun Fire 15K machines have a non uniform memory access (cc-NUMA) archi-
tecture. Thus processors have a quicker access to data on amemory chip on the same
CPU board than to that residing on a different board. Whereas Solaris 8 allocates
data uniformly on all boards, MPO in Solaris 9 tries to place data (pages) on the
same board as the processor, which touches the data first (first touch policy). If you
prefer to distribute the data across the boards, you can start your prgram with the en-
vironment variables

$ LD PRELOAD=nadv. so.1 MADV=access_nany a. out
See the madv.s0.1 and madvi se manual pages for further information. MPO is

The RWTH Sun Fire SMP-Cluster User's Guide, Version 3.1, July 2003 9



nicely described in a detailed whitepaper, which is available on the Sun web site at
http://www.sun.com/servers/\wp/docs/mpo v7 CUSTOMER.pdf.

3.1 Addressing Modes
Solaris 8 and 9 are 64-bit UNIX operating systems. Programs can be compiled and
linked in 32-bit mode (default) or 64-bit mode. This affects memory addressing (us-
age of 32- or 64-bit pointers) and has no influence on the precision of floating point
numbers (4- or 8-byte real numbers). Programs needing more than 4 GB memory,
have to use the 64-bit addressing mode. The switches for UltraSPARC-111 Cu spe-
cific compilation and linking are

- xar ch=v8pl usb 32-bit
- xar ch=v9b 64- bi t

Note | ong i nt data and pointersin C programs are stored with 8 bytes when us-
ing 64-bit addressing mode.

3.2 Batch Job Administration
Batchjobs are handled by the Sun GridEngine (formerly Codine).

Job scripts can be submitted to the batch system with the line command
$ gsub [options] [scriptfile | - [script_args] ]
or through the graphical user interface
$ qnon
The attributes of queued jobs can be modified with
gal ter [options]
Jobs can be deleted with
$ qdel job_id
Status information can be inquired with
$ qstat -f | -j job_id | -u user

On overview of the current batch job load of the entire Sun Fire cluster can be ob-
tained with the utility

j obi nfo RWTH

The most important parametersof gsub are:

10 The RWTH Sun Fire SMP-Cluster User's Guide, Version 3.1, July 2003



-0 [hostname:]path

standard output file

-e [hostname:] path

standard error file

- yln

merge error outputs into standard
output

-l resource=value,...

specification of the necessary
resources (see below)

-N name

job name

-pe parallel_environment ntask

processor count for the MPI
environment (see below)

-v variable[=val ue]

set environment variables

SAY only check the job parameters, do
not submit (this does currently not
work in combination with the -pe
parameter)

-rn no restart, in case of a system crash

-hold_jid job _id.,... start after the termination of the

indicated job

-M mail_address

notification mail address

-mb|elal|s|n

send notification mail at job begin |

end | abort | suspend | send no mail

The RWTH Sun Fire SMP-Cluster User's Guide, Version 3.1, July 2003
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The most important resour ce parameter s are (see qsub- parameter -1 ):

-I hostname=hostname computer name. Normally the use of
this parameter is not recommended.
-I h_rt=hh:mm:ss required real time

[[hours:]minutes:] seconds

Default: 0:10:00

Maximum: 24:00:00

-I h_vmem=xxxX virtual memory

specification in bytes, KB, MB oder
GB

e.g. vmem=10M

default: vmem=1M

-| num_proc=nthread in case of shared memory
parallelization: specification of the
number of threads

-| ostype=sunos start on the SunFire compute nodes.

-| solaris8 during the migration period from
Solaris 8 to Solaris 9 these resource

| solaris9 parameters may be used. Normally
the use of these parametersis not
recommended.

-I mar ch=sf-15k jobs can be directed to the Sun Fire

-| mar ch=sf-6800 15K or to the Sun Fire 6800 nodes.

Normally the use of these
parameters is not recommended.

-| software=#_of _licenses  |the need for software licenses has to
be specified.

Currently the available licensed
packages are: abagus, ansys, cfx4,
cfx5, gamess, gaussian, g98, linda,
marc, matlab, tascflow

The number of licenses normally
equals 1.

- hw_counters Specify thisresource, if you want to
collect performance information
(collect command).
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MPI-Jobs have to be submitted into one of the following "parallel environments”.
The number of MPI processes has to be specified (nproc)

-pe mpi_sunos_* nproc the MPI job will be started on any
of the Sun Fire machines

-pe mpi_sunos 6800 nproc |the MPI job will be started on Sun
Fire 6800 nodes only

-pe mpi_sunos 15k nproc  |the MPI job will be started on Sun
Fire 15K nodes only

-pe mpi_sunos_1host nproc |all processes of the MPI job will be
started on any one Sun Fire
node.All MPI communication will
use the common main memory.

The parameters can aso be indicated as comment lines, starting with the characters
"#3$", in the beginning of the job scripts. Command line parameters have higher
precedence than the imbedded script flags.

Submitting a seria job:

$ qsub -o $HOVE/ aus.txt -j y -1 ostype=sunos \
-1 h_rt=00:15:00 -1 h_vnmem=500M scriptfile

This corresponds to

#! [ usr/ bi n/ ksh

#$ -o $HOWE aus. t xt
#S -]y

#$ -1 h_rt=00:15: 00
#$ -1 h_vrmem=500M
#$ -1 ostype=sunos

cd workdir
program

Example of abatch job script for starting a Sun MPI program:

(The environment variable MPRUN_FLAGSES is predefined by the batch system in
order to direct the MPI processes to the reserved machines. The limits are per proc-
ess limits, so in total 5 times 500 MB will be reserved.)

#! [ usr/ bi n/ ksh

#$ -N MPI - Test-Job
#$ -1 h_rt=00:15: 00
#$ -1 h_vrmem=500M
#$ -pe npi_sunos_* 5
#$ -1 ostype=sunos
cd workdir

nprun program

Example of a batch job script starting an OpenMP or an autoparallel program:
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(The environmentvariable OMP_NUM_THREADS is predefinedby the batch
systemin orderto startas manythreadsasprocessoriavebeenreserved 500 MB
will be reserved on one node for all 5 threads.)

#! [/ usr/ bi n/ ksh

#$ - N OpenMP- Test - Job
#$ -1 h_rt=00:15: 00
#$ -1 h_vrmem=500M

#$ -1 num proc=6

#$ -1 ostype=sunos

cd workdir

program

Hybrid Programausea combinationof MPI andOpenMP ,whereeachMPI process
is multi-threaded. Example of a batch job script starting a hybrid program:

(The environmentvariables MPRUN_FLAGS anc OMP_NUM_THREADS are
predefinedby the batch system.In this example5 groupsof 4 CPUswill be re-
served.)

#! [/ usr/ bi n/ ksh

#$ - N Hybrid-Test-Job
#$ -1 h_rt=00:15: 00
#$ -1 h_vrmem=500M

#$ -1 num proc=4

#$ -pe npi _sunos_15k 5
#$ -1 ostype=sunos

cd workdir

nprun program

3.3 Defaults of the User Environment
Thelogin shellis the korn shell (ksh). It's promptis symbolizedby the dollar sign.
Accordingly numerougnitialization scriptsfollow this syntax.They mustbe started
with

$ . scriptfile
Environment variables are set with
$ export vari abl e=val ue
This corresponds to the C shell command
% setenv vari abl e val ue

If you preferto usea different shell, startany necessarynitialization scriptsbefore
you change to your preferred shell.

$ . init_script

$ exec csh

%
The C shell prompt is indicated with “percentage” symbol.

For the useof the Sun ONE Studio 8 Compiler Collection endronmentand HPC
ClusterToolsthe environmentvariablesPATH and MANPATH arealreadyadaptedn
the user profile:
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$ export PATH=${PATH}:\

[ opt / SUNWpr o/ bi n: / opt SUNWhpc/ bi n
$ export MANPATH=${ MANPATH} : \

[ opt / SUNWspr o/ man: / opt SUNWhpc/ man

3.4 User File Management
Every user owns directories on shared file systems for small, long-term user files
(PHOVE=/ hone/ usernanme) and for large, medium-term  workfiles
($WORK=/ wor k/ user nane). The $HOVE data will be saved regularly.

A directory for local scratch files ($TMP=/t np/ user nane/ | ogi n_pi d) is ac-
cessible only on the respective node and will be automatically created before and de-
leted after the terminal session or the batch job.

The RWTH Sun Fire SMP-Cluster User's Guide, Version 3.1, July 2003 15



4 Programming/Tuning

4.1 Sun Compilers

16

The Sun ONE Studio 8 Development Tools are now in production mode and the de-
fault compilers. They include the Sun Fortran 95 7.1, Sun C 5.5 and Sun C++ 5.5
compilers. If necessary you can use the previous version of the compilers by modifi-
cation of the search path with the following commands [FYIE

$ . studio7.init # previous conpiler

We recommend that you always recompile your code with the latest production com-
piler for performance reasons and bug fixes.

Check the compiler version which you are currently using with the option
-V

or with the command
$ dunpst abs object file

Online information in addition to the manual pages can be found by directing your
browser to the local file

file:///opt/ SUN\Mspro/docs/index. htm
or to the website

http://docs. sun.confdb/col I /771. 2
Particularly the new features are described in

http://docs. sun. conf source/ 816-452/1. htm
The compilers are invoked with the commands

$ cc, c89, c99, f90, f95, CC

The appropriate manual pages are available. You can get an overview of the avail-
able compiler flags with the option

-flags
It isin general recommended to use the same flags for compiling and for linking.

From Studio 7 on, there no longer is a separate Fortran 77 compiler available.
But there is an additiona option in the new Fortran95 compiler improving the com-
patibility to Fortran 77

-f77

which has several suboptions. Using this option without any suboption list expands
to

-ftrap=%one -f77=%al |

which enables all compatibility features at the same time and also mimics the For-
tran 77's behavior regarding arithmetic exception trapping. We recommend to add

-f77 -ftrap=conmon
in order to revert to thef 95 trapping, which is considered to be safer.
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When linking to old f 77 object binaries, you may want to add the option
-xlang=f77
at the link step.

Detailed information about compatibility issues between Fortran 77 and Fortran 95
can befound in

http://docs.sun.com/source/816-2457/5 f77.html

Compute intensive program parts can be translated and linked with the optimization
options (US-111 Cu)

-fast —xarch=v9b (64 bit addressing) or
-fast —xarch=v8plusb (32 bit addressing)

-fast isamacro expanding to severa individual options, which are meant to give
you the best performance with one single compile and link (!) option. Note however
that the expansion of -fast might be different across the various compilers and
can change between different compiler releases.

At present (Studio 8) -fast  with the Fortran 95 compiler corresponds to the fol-
lowing list (see manual page):

-O5 -xarch=native —xpad=local —xvector=yes
-xprefetch=auto,explicit —dalign —fsimple=2
—fns=yes —ftrap=common —xlibmil —xlibmopt
-xdepend=yes -fround=nearest

with the C compiler:

-fns —fsimple=2 -fsingle —ftrap=%none -
xalias_level=basic -xarch=native —xbuiltin=%all
-xdepend —xlibmil -xmemalign=8s
-xprefetch=auto,explicit -xO5

and with the C++ compiler:

-XO5 -xarch=native -xmemalign=8s —fsimple=2
-fns=yes —ftrap=%none —xlibmil -xlibmopt
-xbuiltin=%all

For further optimization by the C-compiler the following options can be added:
—xvector —xspfconst

and for further optimization by the C++-compiler the following options can be
added:

-xalias_level —xvector —xspfconst
-X prefetch=auto,explicit

The generated code can be specifically tuned for the 900 Mhz-UltraSPARC-111 Cu
processor (US-I11 Cu) by specifying
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-xchi p=ul tra3cu -xcache=64/32/4:8192/512/2 \

- xar ch=v8pl usb (32-bit addressing mode)
-xchi p=ul tra3cu -xcache=64/32/4:8192/512/2 \
- xar ch=v9b (64-bit addressing mode)

In general it is recommended to specify the precise architecture flags for linkage as
well (-xarch=v8plusb / vob for the UltraSPARC-I11 Cu processor), so that the opti-
mal run time libraries are used.

Y ou can get asurvey of the compiler flags used by adding the option

—v (Fortran and C++)
-# (0

The compiler supports inlining of function and subroutine calls. With optimization
level -xO4 and above, this is attempted for functions/subroutines within the same
source file. The programmer can also specify which functions/subroutines should be
inlined, by specifying these with the following option

-xinline=routine_list

Note however that in this case, automatic inlining is disabled. It can be restored
through the %auto option. We therefore recommend the following:

-xinline=%ut o, routine_l|i st

If one wishes to have the compiler perform inlining across various source files, the -
Xipo option can be used. This is a compile and link option. With the 7.0 release, -
Xipo=2 is also supported. This adds memory related optimizations to the interproce-
dural analysis.

Program kernels with numerous branches can be further optimized with the profile
feedback method. This two step method starts with a compile using this option added
to the regular optimization options:

—xprofile=collect:a.out

Then the program should be run for one or more data sets. During these runs, run-
time characteristics will be gathered.

The second phase consists of are-compile, using the run-time statistics:
—xprofil e=use: a. out

This will then hopefully give a better optimized executable, but keep in mind thisis
of benefit for specific scenario's only.

NOTE: High optimization can have an influence on floating points results due to
different rounding errors. In order not to change the order of the arithmetic opera-
tions by the optimization, a further option can be added, which reduces the execution
speed however:

-fast —fsinple=0 —xnol i bropt (Fortran)

The option
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-9
produces debugging information. Thisis aso useful for run-time analysis with the
Performance Analyzer, which can use the debugging information to attribute time
spent to particular lines of the source code. Use of - g does not substantially impact
optimizations performed by the new Sun compilers. Meanwhile, the correspondence
between the binary program and the source code is weakened by optimization, mak-
ing debugging more difficult.

The Fortran compiler printsalot of information (compiler messages, cross reference
list, etc.) about the program in a separate listing file when compiling with the option

$ f90 -Xlist ... programf
$ cat programl st

The default data mappings of the Fortran compiler can be adjusted with the -type-
map option. The normal setting is

-typemap=real : 32, doubl e: 64, i nteger:32 ...
For example with

$ 90 -typemap=real: 64, doubl e: 64, integer:32 ...
the REAL type can be mapped to 8 bytes.

When using the - g option, the latest Sun compilers introduce comments about 1oop
optimizations into the object files, which can be output by the command

$ er_src prognane.o
A comment like

Loop bel ow pipelined wth steady-state cycle
count . .

indicates that modulo scheduling (aka software pipelining) has been applied, which
in general gives better performance.

An expert of the chip architecture will be able to judge by the additional information,
if further optimizations are possible.

With the help of the er_src command a successful subroutine inlining can also be
easily verified:
er_src *.o | grep inline

NOTE: The compiler options are interpreted from left to the right. In the case of
contradictory options the right most dominates.
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4.2 The KCC C++ Compiler by KAI

KCC is an excellent C++ compiler by Kuck & Associates. KCC trandates C++ pro-
grams to an intermediate C code, which then can be compiled by a native C com-
piler. KCC isimbedded in the guidec++OpenMP compiler.

The most important KCC flags are

+K3 maximum optimization

-O<n> resp. —fast optimization level of the back-end C compiler (will
be passed through)

-k or -keep_gen_c do not delete the generated intermediate C code.

The C code stored into <filename>.int.cmight be
interesting, but it is hard to read.

-V verbose mode
--backend ... pass the following option to the back end compiler
-C, -0 will be passed through as well.

4.3 Interval Arithmetic

The Sun Fortran and C++ compilers support interval arithmetic by an intrinsic | N-
TERVAL datatype and the UltraSPARC-111 Cu processor supports fast switching of
the rounding mode of floating point operations.

The use of interval arithmetic requires the use of appropriate numerical algorithms.

4.4Tuning Tips

20

Compiler options, compiler directives, programming techniques and last but not least
the Sun performance library with highly optimized routines can be used for acceler-
ating programs.

Recently an excellent book covering this topic particularly on UltraSPARC comput-
ers has been published:

Rajat Garg and Ilya SharapovTechniques for Optimizing Applications:
High Performance Computing,l SBN:0-13-093476-3, published by Pren-
tice-Hall PTR/Sun Press.

Contiguous memory accessis critical for reducing cache and TLB misses. Thishasa
direct impact on the addressing of multidimensional fields or structures. Therefore
Fortran arrays should be processed in columns and C and C++ arrays in rows. When
using structures, al structure components should be processed in quick succession.
Frequently this can be achieved by the technique of the loop interchange.

The limited memory bandwidth of RISC processors like the UltraSPARC |11 is a se-
vere bottleneck for many scientific applications. With prefetching data can be loaded
in advance from the memory into the cache and into the registers. This can be sup-
ported automatically by hard- and software but also by explicitly adding prefetch di-
rectives resp. calls.

The re-use of cache contents is very important, in order to reduce the number of
memory accesses. If possible block algorithms should be used e.g. from the opti-
mized Sun performance library described below.

Cache behavior of programs can be improved frequently by the techniques of loop
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fission (=loop splitting), by loop fusion (=loop collapsing), by loop unrolling (see
option xunr ol | =n), by loop blocking, the strip mining and by combinationsof
thesemethods.Conflicts causedby the mappingof storageaddresseso cachead
dressesanbe easedy the creationof buffer areagpadding) (seecompileroption—
pad).

With the option —dal i gn the memoryaccesson 64 bit data can be accelerated.
This alignmentpermitsthe compilerto usesingle 64 bit load andstoreinstructions.
Otherwise the programmustusemorethanoneinstructionfor eachmemoryaccess.
However this option must be applied to each routine.

With this option, the compiler will assumethat double precision data has been
alignedon an 8-byte boundary If the applicationviolatesthis rule, the run-timebe-
haviour is undetermined, but typically the program will crash.

Onwell-behavedorogramsthis shouldnot be anissue,but careshouldbe takenfor
thoseapplicationghat performtheir own memorymanagemenswitchingthe inter-
pretationof a chunk of memorywhile the programexecutes. A classicalexample
canbe found in some(older) Fortranprograms. A largeINTEGER COMMON -
blockis allocatedput lateronthisis declaredo beaDOUBLE PRECISIONCOM-
MON -block of half the size.Undersuchcircumstancesa misalignmenbf datacan
easily happen.

NOTE: The-dal i gn optionsis actuallyrequired for FortranMPI programsand
for programdinked to otherlibrarieslike the SunPerformance.ibrary andthe NAG
libraries.

The compiler optimizationcan be improved by integratingfrequently called small
subroutinegnto the calling subroutineqinlining). The expensefor the subroutine
call will be avoided thereby.

-xinline=routinel, routine2,...
(Inlining of routines from the same source file)

-xO4 —xcrossfile

(Inlining of routines from other files in the same compiler call)
- X1 po

(Inlining of routines from other files in different compiler calls)

In C and C++ programsthe useof pointersfrequentlyobstructsthe possibility for
optimization by the compileThrough corpiler options

—xrestrict andxal ias_| evel =. ..
it is possible to give additional information to the C-compiler.
With the directive

#pragma pi pel oop(0)

in front of af or loop it canbe indicatedto the C-compilerthatthereis no datade-
pendency present in the loop.

Word of caution. These options and the pragma make certain assumption. When us-
ing these mechanisms incorrectly, the behaviour of the program becomes undefined.
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Please study the documentation carefully before using these options or directives.

4.5 Time measur ements

For real time measurements a high-resolution timer is available. However, the meas-
urements can supply reliable, reproducible results only on an (almost) empty ma-
chine. At least the number of runnable processes (use upt i me command) plus the
number of processors needed for the measurement has to be by far less than the
number of processors available on the compute node.

Examplein C

#i ncl ude <sys/tine. h>

/* Real timein nanoseconds as longlongint */
doubl e second;

second = (double) gethrtinme() * 1.0E-9;

and in Fortran

| NTEGER*8 get hrtine
REAL*8 second
second = 1.d-9 * gethrtinme()

CPU time measurements have a smaller precison and are more time costly. For
measuring large time intervals they are quite suitable.

In case of paralel programs, real time measurements should by made anyway!
After linking alibrary supplied by the computing center:
-L/usr/local _rwth/lib —lr_lib [

the functionsr _rtinme andr _cti ne are available. They return the real time and
the CPU time, respectively, as double precision floating point numbers.

4.6 Har dwar e Perfor mance Counters

22

The UltraSPARC-I11 Cu chip offers 2 programmable 32-bit performance counters
for counting various hardware events.

The cput rack command (seeman cput r ack), thecpc-library (seeman cpc),
the portable PCL-library or the Performance Analyzer (see chapter 7) can be used to
access these counters.

The command
$ cputrack —h

lists the names of the countable events. A ssimple application can be seen in the shell
script

[usr/1ocal _rwth/bin/nflops [{ULl
Just call
$ /usr/local _rwth/bin/nflops a.out
to count the number of floating pointsinstructions during the execution of a. out in
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MFlop/s.
$ man cpc_bi nd_event
displays an example program using the cpc library.

The portable performance counter library (PCL) profits from the cpc library. It can
be linked by

$ f90 —L/usr/local _rwh/lib —lpcl —lcpc ...

A more elegant way of obtaining performance information is the use of the collect
command and the er _print utility or the analyzer GUI (see chapter 7).
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5 Paralldlization

Parallelization for computers with shared memory (SM) means either the automatic
distribution of loop iterations on several processors or the explicit distribution of
work on the processors by compiler directives and function calls (OpenMP) or a
combination of both.

Parallelism for computers with distributed memory (DM) is done via the explicit dis-
tribution of work and data on the processors and their coordination with the ex-
change of messages (M essage Passing with MPI).

MPI programs run on shared memory computers as well, whereas OpenMP pro-
grams (normally) do not run on computers with distributed memory. As a conse-
guence MPI programs can use all available processors of the SMP cluster, whereas
OpenMP programs can use up to 24 processors of a Sun Fire 6800 node, or up to 72
Processors of a Sun Fire 15K node.

For large applications the hybrid parallelization approach, a combination of coarse-
grained parallelism with MPI and underlying fine-grained parallelism with OpenMP,
might be an attractive possibility, in order to use as many processors efficiently as
possible.

5.1 M essage passing with M PI

5.1.1Sun MPI

Sun MPI is the Sun implementation of the MPI standard and is part of the Sun HPC
ClusterTools software suite. At present, HPC ClusterTools 5.0 isinstalled.

The compiler drivers mpf77, mpf90 , mpcc and mpCC and the instruction for start-
ing an MPI application mprun are in the directory /opt/SUNWhpc/bin. The neces-
sary include directory /opt/SUNWhpc/include and the library directory
lopt/SUNWhpc/lib are picked up automatically by these compiler drivers.

Example (recommendation):

$ npf90 —c -dalign ... *.f90
$ npf90 -0 a.out *.o0 -Inpi
$ nprun —-np 4 a.out

Example (only for explanation):

$ f90 —I /opt/SUNwWhpc/include —c -dalign ... *.f90
$ f90 —0 a.out *.o0 —L/opt/SUNWhpc/lib —I npi
$ / opt/ SUNWhpc/ bi n/ nprun —np 4 a. out

MPI programs can be started with the command
$ nmprun [options] program

The command mprun has numerous flags for placing the MPI tasks on the compute
nodes and for input and output control (see also man mprun and mprun -h).

5.1.1.1 Placing the MPI-Taskswith npr un

24

The following table contains the most important parameters of mprun for the distri-
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bution of the MPI tasks on the involved machines.

Please note however, that large computing jobs should not be started interactively,
and that with use of batch jobs (see chapter 3), the GridEngine batch system deter-
mines the distribution of the MPI tasks on the machines to a large extent.

Small MPI test jobs can be started on the interactive node, where you use to logged

in by just specifying

nprun -np n program

because the environment variable MPRUN_FLAGS is predefined in the user profile
such that all MPI processes will be started on the current machine.

-1 "suncOl 2, sunc02 3"

-J Prints the job identification number

-np n Start of exactly n MPI tasks

-np O Start of exactly one MPI task for each
processor

-S —-np n Start n MPI tasks, but settle for one
process per CPU if not enough CPUs
are available.

-W-np n Cyclic distribution of the MPI tasks
on the processors, if the number of
MPI tasksislarger than the number of
the processors of the SMP node.

-np n\ Explicit distributing of then MPI

tasks to the indicated SM P nodes.
Note: capitalization is relevant

—np n —m rankmapfile

Explicit distribution of then MPI
tasks on SMP nodes listed in afile.

-np n —Ns Start of exactly one MPI task on each
of n SMP nodes.

-Zt m-np n Start of n MPI tasks in groups of m on
each of the involved nodes.

-Z m-np n Start of n MPI tasks in groups of m.

Several groups on a sufficiently large

SMP node are allowed.

5.1.1.2 Input and output control with npr un

Under normal conditions standard input (stdin) is passed to all MPI tasks by the
mprun, command. Standard output (stdout) as well as standard error output (stderr)
of all tasks are passed to the standard output of mprun.
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By further options of the command mprun this behavior can be modified:

-D The error outputs of the tasks are passed to the
error output of the mprun command.

—N All standard input and output is turned off.

—n /dev/null is passed to the standard input. That

can be useful for MPI jobs, which run in the
background (e.g. as a batch job), so that they
do not block, if they wait unintentionally for an
input. In this case they will read an EOF.

-B The output of the tasksiswritten to files
named out.jid.rank.
-0 The output is buffered line by line and the rank

of the respective process is written on the
beginning of each line.

-l "Or, 1w, 2w " more precise controlling of the input and
output. Only complete lines will be written.

-1 "Or, 1w, 2wt " Only complete lines are output and all lines
have the task rank placed in front.

—1 "Or =i nput , \ All tasks read the same input file, but write in

1wt =out . &J. &R\ separate output and error output files

2w=err. &J. &R"

5.1.1.3 Handling MPI program runs

Y ou can terminate a MPI job with the job identification number jid
(see: nprun =J) by:

$ mpkill jid
The command mpps gives a list of the processes, that run under the control of the
MPI run time system (CRE=cluster run time environment).

$ npps —pef
The command mpinfo gives an overview of the configuration of all nodes attached
to the CRE. Example:

nmpi nfo =N

5.1.1.4 Sun MPI environment variables

26

Numerous environment variables can govern the behavior of an MPI program and
improve its performance.

In the case of exclusive use of the involved SMP nodes, in particular if one processor
in each node is kept free for system processes, which is typically the case in the
RWTH batch environment, it’s possible to accelerate a program with:

$ export MPlI_SPIN=1

The MPI tasks wait then actively (busy waiting, spinning) for messages and keep
their processor busy thereby.

In some cases (e.g. pingpong tests)
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$ export MPI _POLLALL=0
accelerates the application (do not poll).
In case of problems more run time messages can be printed through

$ export MPI _SHOW | NTERFACES=3
$ export MPlI _SHOW ERRORS=1
$ export MPI _CHECK ARGS=1

The current values of all MPI related environment variables will be listed at the pro-
gram start with:

$ export MPI_PRI NTENV=1

The Sun HPC ClusterTools Performance Guide contains many tips for the tuning of
MPI applications (http://docs-pdf.sun.com/816-0656-10/816-0656-10.pdf).

N=The new HPC ClusterTools Version 5.0 includes a novel profiling tool
nppr of which is easy to use and gives hints for setting additional environment
variables which might improve the performance of a similar program run.

After enabling MPI profiling by setting the environment variable

$ export MPI _PROFI LE=1
$ nprun -J -np n ... a.out

the MPI program run will write out profiling date for the MPI process ranks to a set
of intermediate files, one file per process rank, as well as an index file pointing to the
intermediate files. The nppr of command then generates a report of the perform-
ance characteristics of the MPI program

$ npprof npprof.index.cre.jid

with j i d being the job ID of the cluster runtime environment (CRE) printed out
with the - J option of the npr un command. The report also contains recommenda-
tionsfor settings or modifications of MPI environment variables. The process of pro-
filing and modifying these variables can be iterated, until the performance is optimal
and no further hints are given.

The collection of profiling data can be controlled by additional environment vari-
ables which are described in the manual page (man nppr of ).

5.1.2 mpich

With the improved interoperability of the latest version 6.1 of the Totalview debug-
ger and the upcoming HPC ClusterTools 5.0 we will no longer support mpich on the
Sun platform. N=2]

5.2 Shared memory programming with OpenM P
For shared memory programming OpenMP is becoming the de facto standard. The
OpenMP API is defined for FORTRAN, C and C++ and consists of compiler direc-
tives, run time routines and environment variables.

In the parallel regions of a program several threads are started, that execute the con-
tained program segment redundantly, until they hit a worksharing construct. Within
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this construct, the contained work (usually do- or for-loops) is distributed among the
threads. Under normal conditions all threads have access to all data (shared data).
But pay attention: if data, accessed by several threads, is modified, then the access to
this data must be protected in critical regions.

Also private data areas can be used, where the individua threads hold their tempo-
rary data. All local data of subroutines, which are called within paralel regions, are
put on the stack, and thus don’t keep their contents from one call to the next!

Therefore, Fortran programs must be translated with the option —st ackvar . COM
MON blocks, data in modules or SAVE statements must be used with caution (thread
safety).

Attention! In many cases, the stack area for the slave threads must be increased by
changing the environment variable STACKSI ZE, or the stack area for the master
thread must be increased with the (Korn shell) command ul i m t (specification in
KB). It isrecommended to use the new compiler option (version 7.0)

-xcheck=st kovf
in order to detect stack overflow at runtime.

Hint: In aloop, which is to be parallelized, the results must not depend on the order
of the loop iterations! Try to run the loop backwards in serial mode. The results
should be the same. (Thisis a necessary, but not a sufficient condition!)

The number of the threads to use is indicated by the environment variable
OVP_NUM_ THREADS.

Notes: If OVP_NUM THREADS is not set, then Sun OpenMP starts only 1 thread (as
opposed to the Guide compiler from the KAP/Pro Toolset which starts as many
threads as there are processors available).

On aloaded system fewer threads may be employed than specified by this environ-
ment variable, because the dynamic mode is used by default (as opposed to the
Guide compiler). Use the environment variable OVP_DYNAM C to change this be-
haviour.

5.2.1 Sun-OpenMP

28

By adding the option

- xopennp
the OpenMP directives (according to the latest OpenMP 2.0 specifications) are inter-
preted by the Fortran95 compiler. This option is an abbreviation for

—np=opennp —explicitpar —-stackvar —D_OPENWP -3

Fortunately, the explicit parallelization can be combined with the automatic paralle-
lization of the Fortran compiler. Loops within parallel OpenMP regions are no
longer subject to automatic parallelization. Nested parallelization is not (yet) sup-
ported.

The C- and C++-compilers support OpenM P as well after adding the option
- xopennp
Enabling OpenMP[tm] parallelization with the -xopenmp option makes a program
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potentially multi-threaded, but the - D_REENTRANT flag is not passed to the com-
piler. The lack of the - D_REENTRANT flag causes some code (particularly the tem-
plates from the Standard C++ Library) to compile with thread synchronization dis-
abled, which can result in programs silently getting wrong answers.

Workaround: Include the - D_REENTRANT flag on the compiler command line
whenever you include the -xopenmp option (http:
//docs.sun.com/source/816-6727/rel notes.html#Documentation).

Between parallel regions the slave threads go to sleep. How they are woken up is
controlled by the environment variable SUNW MP_THR_| DLE. The possible values
are:

$ export SUNW MP_THR I DLE=spin | sleep | ns | nns

The slave threads wait either actively (busy waiting, by default) and thereby con-
sume CPU time or passively (idle waiting) and must then be woken up by the system
or in a combination of these methods they wait first actively and fall asleep n sec-
onds or n milliseconds later. With fine-grained parallelization active waiting and
with coarse-grained parallelization passive waiting is recommended. Idle waiting
might be advantageous on an overloaded system.

Setting
export SUNW MP_WARN=TRUE
enables additional warning messages of the OpenMP run time system.
Use the new Fortran compiler option
-Xli st MP
to receive additional OpenMP related messages in the listing files (*.Ist)

5.2.2 KAP/Pro Toolset

The KAP/Pro Toolset from the Kuck & Assoc. Inc. (KAI) contains OpenM P compil-
ers and tools.

The Guide compilers interpret OpenMP directives in Fortran, C and C++ programs
and generate intermediate programs with calls to the pthread library.

By just replacing the compiler and linker callsto
$ guidef 77 | guidef90 | guidec | guidec++
appropriate compiler drivers are used.
By adding the
-WEkeep
flag the intermediate programs are kept. By linking with the option
-Wast at s

a statistics file is written during program execution, which can be nicely visualized
with

$ gui devi ew
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A remarkable tool for the verification of the correctness of OpenMP programsis As-
sure. Replacing the compiler and linker calls by

$ assuref 77| assur ef 90| assur eclassurec++ \
- WGpname=pr oj ect

the program is instrumented, such that during the program execution every memory
access istraced in order to detect possible data races.

The results of thisanalysis can be displayed with the GUI
$ assurevi ew —pnane=pr oj ect

or printed out in line mode by
$ assureview —txt —pnane proj ect

The instrumented program will take about 10 times more CPU time and 10 times
more memory!

Recommendation: Never put an OpenMP code into production, before using
Assure!

5.2.3 Automatic shared memory parallelization of loops

30

The Sun Fortran- and C-compilers are able to parallelize loops automatically.

Success or failure to do so depends on the compiler's ability to be able to proveit is
safe to parallelize a (nested) loop. This is often application area specific (e.g. finite
differences versus finite elements), language dependent (pointers may make the
analysis hard) and coding style.

The respective option is
- Xxaut opar

The - aut opar optionisan abbreviation for
—xaut opar —depend —xC3

The combination of explicit paralelism by directives and automatic parallelism is
accessible by the option

-xparal | el
as an abbreviation for
- xaut opar —xexplicitpar —depend —xO3

Not only OpenMP directives are interpreted, but also proprietary paralelization di-
rectives of Sun and Cray, which, since OpenM P becomes more and more a standard,
should not be used anymore. Adding

- np=opennp

limits the compiler to OpenMP directives, if for historical reasons also different di-
rectives should be still contained in the program.

With the option
- Xreduction

automatic parallelization of reductions is also permitted, e.g. accumulations, dot
products etc., whereby the modification of the sequence of the arithmetic operation
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can cause different rounding error accumulations.
Compiling with the option

- x| oopi nfo
supplies information about the parallelization.

If the number of loop iterations is unknown during compile time, then code is pro-
duced, which decides at run-time whether a parallel execution of the loop is more ef-
ficient or not (alternate coding).

Also with automatic parallelization, the number of the used threads can be specified
by the environment variable OMP_NUM_ THREADS.

5.4 Hybrid Parallelization

The combination of MPI and OpenMP and/or autoparallelization is caled hybrid
parallelization. Each MPI process is multi-threaded. It isimportant to link the thread-
safe version of the MPI library:

$ mpf 90 -opennp -fast -c program f90
$ npf90 -opennmp -fast -0 a.out programo -l npi_nt
$ export OVP_NUM THREADS=n
$ nprun -np m a. out
KAI's guide preprocessors can be used as well:
$ gui def 90 -Wjconpi | er=npf 90 -opennp -fast -c \
program f 90
$ gui def 90 - Wjconpi | er =npf 90 - opennp -fast \
-0 a.out programo -lnpi_nt
$ export OVP_NUM THREADS=n
$ nprun -np m a. out
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6 Debugging
If your program is causing problems, it might be good opportunity to lean back and
think for awhile.

Take a step back:

What were the last changes that you made? (A source code revision system (RCS,
CVS) might help.)

Reduce the number of CPUsin aparallel program, try a serial program run if pos-

sible.

Reduce the optimization level of your compilation.

Chose asmaller data set. Try to build a specific test case for your problem.

Look for compiler messages and warnings. Use tools for a static program analysis
(see chapter 6.1).

Try a dynamic analysis with appropriate compiler options (see chapter 6.2). In
case of an OpenMP program, use Assure (see chapter 5.2.2).

Use adebugger. Use the smallest case which shows the error (see chapter 6.3).

6.1 Static program analysis

First, an exact static analysis of the program is recommended for error detection. The
Fortran compiler offers an -Xlist option which generates warning and error messages
into additional listing files (file extension .Ist). For OpenMP programs there is a
new option -XlistM P. Furthermore the following tools can be used for static analy-

Sis:
CC -V .. |gtricter semantic checksof C programs by the compiler
l'int more accurate syntax check of C programs
ftnchek |more accurate syntax check of Fortran77 programs
f oresys |more accurate syntax check of Fortran77 and Fortran90 programs
and more

Sometimes, program errors occur only after high optimization by the compiler. That
can be a compiler error or a programming error. If the program runs correctly with-
out compiler optimizations, the module causing the trouble can be found by system-
atic bisectioning.

6.2 Dynamic program analysis
The program can be further checked by translation with certain options:

32
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-C array bound check d¢fortran programs

-Xli st global program analysis, write detailed list to files with the
ending.Ist
-ftrap=%al | pursue of floating point errors, like division by zero,

overflow, underflow. The error handling can be
programmed also explicitly, seman ieee_handler

-g enrich the binary program with debugger information, for
step-by-step debugging, turn off all optimizations)
-xcheck=stkovf check stack overflow at runtime, new with version 7

A new extensionto the - xcheck option flag enablesspecialinitialization of local
variables.Compilingwith - xcheck=i nit _| ocal initializes local variablesto a
valuethatis likely to causean arithmeticexceptionif it is usedbeforeit is assigned
by the program Memory allocatedby the ALLOCATE statementvill alsobeinitial-
izedin this manner SAVE variables modulevariables,andvariablesin COMMON
blocks are not initialized.

The sampling collector (see chapter 7.1) is now also able to detect memory leaks
collect -H

A core dump can be analyzed with the debugger, if the program was translated with
g:

$ dbx a.out core

$ total view a.out core

If a programwith optimizationdeliversotherresultsthanwithout, thenthe changed
roundingerrorbehaviorcanberesponsibleThereis a possibility to testthis by opti-
mizing the program “carefully”

$ f90 ... —fsinple=0 -xnolibnopt...

Thus,the sequencef the floating point operationdgs not changedoy the optimiza
tion, which can increase the run time.

6.3Debuggers
At presentfour differentdebuggersare available.In all caseshe programmustbe
translatecandlinked with the option —g andwithout optimization(at leastin the in-
teresting program parts).

Don'tforgetto increasethe corefile sizelimit of your shell,if you wantto analyze
the core that your program may have left behind:

ulimt -c unlimted
But please don't forget to purge core files afterwards!

6.3.1dbx
dbx is a powerfuline orientated debugger with a detailed online help.

The RWTH Sun Fire SMP-Cluster User's Guide, Version 3.1, July 2003 33



It can as well be used to debug long running programs in batch mode. Collect the
dbx commands in an input file and start your program under control of dbx:

$ cat >> dbx.in < ECF
catch FPE

cat ch SI GSEGV

cat ch SI GBUS

run inputfile

wher e

dunmp

qui t

EOF

$ dbx a.out < dbx.in

Y ou may aswell debug MPI-Programs this way:
nmprun -np ntasks -o dbx a.out < dbx.in

It might be more comfortable only to run afew MPI processes through the debugger.
This can be accomplished by starting a small shell script like the following:

#!/ bi n/ ksh

# giving the corefile a useful nane ...

coreadm -p core. %. % . p%. ] ${ MP_JOBI D} . t SMP_RANK  $$;
# mechanismto restrict debugging to a subset of M

processes ...
if [[ SMP_RANK < 2 ]]
t hen
dbx a.out < dbx.in > dbx.out.t$VMP_RANK
mpkill -9 $MP_JOBI D
el se
debug. exe

fi

This script, using the same input file dbx. i n for dbx like above, isthan run with
nprun ... rundebug. ksh

This will leave some core files with meaningful names behind, which then can be
analyzed with

dbx a.out core. machi nenane. a. out. pnnnn. j mmm t kk

6.3.2 Prism
prism is agraphic debugger for Sun MPI programs.
If the help information browser does not start correctly, use
$ export PRI SM BROWSER _SCRI PT=yes
AT he syntax for starting pr i smhas changed in Sun HPC ClusterTools 5.0:
$ nmprun <mprun_options> prism <prismoptions>
The <prism_options> no longer include any options for controlling the number of

34 The RWTH Sun Fire SMP-Cluster User's Guide, Version 3.1, July 2003



processes, or process placement. Use the <mprun_options> for such control. Exam-

ples:
$ mprun -np 8 prism program
$ mprun -np 8 prism programjid
$ mprun -np 8 -Zt 2 prism pr ogr amcorefile
6.3.3 TotalView

The state-of-the-art debugger TotalView from Etnus (http://www.etnus.com/) can be
used to debug serial and parallel Fortran, C and C++ programs. It is available on all
major platforms.

A The latest version 6.1 of the TotalView debugger supports the latest Sun com-
pilers aswell asthe latest version of the Sun HPC ClusterTools.

As an appendix a we include a TotalView Quick Reference Guide for the Sun Fire
SMP cluster.

6.3.3.1 Invocation of TotalView for serial programs

$ . totalview.init
$ totalview program[ corefil e]

6.3.3.2 Debugging of Sun-MPI programs [Jf%]

$ . totalview.init
$ totalview mprun —a —np 2 —| “$(hostname) 2" a.out

Initially a dummy program is displayed in the source window. After pressing Go the
user program is entered. A few preferences should be changed beforehand:

Add /opt/SUNWhpc/lib in

File - Preferences - Dynamic Libraries
and turn on Stop the goup in

File - Preferences - Parallel

Save these settings with Save.

Now start your parallel program with Go, the source of your main program will be
displayed and the debugging session starts.

Outstanding non-blocking messages can be displayed with the Tools > Mes-
sage Queue Window or the Tools > Message Queue Graph

6.3.3.3 Debugging of OpenM P-programs

Before debugging an OpenMP program, the corresponding serial program should
run correctly. The typical OpenMP parallelization errors are data races, which are
hard to detect in a debugging session, because the timing behaviour of the program
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is heavily influenced by debugging.
It is recommended to use the new Fortran compiler option
-XlistMP

to do a basic static program check. Furthermore the Assur e tool is recommended for
the verification of OpenMP programs (see chapter 5.2.2).

But interactive debugging is possible as well. By default the Sun compilers
OpenMP options require high optimisation (-xO3) which in turn prohibits debug-
ging. Since Studio 8 it is possible to debug Fortran and C programs using OpenMP
after compiling with a new suboption

$ f90 -opennp=noopt -g ...
$ cc -xopenmp=noopt -g ... [QUL

As an alternative you can use KA’ s guide precompiler, which can be combined with
TotalView.

Example:
$ gui def90 -WG, -cnpo=i [-WEkeepcpp] —-g —-c *.f90
$ guidef90 -WG, -cnpo=i —g -0 a.out *.o
$ export OVP_NUM THREADS=2

$ . totalviewinit
$ total view a. out

For the interpretation of the OpenMP directives, the original source program istrans-
formed. The parallel regions are outlined into separate subroutines. Shared variables
are passed as call parameters and private variables are defined locally. A pardlel re-
gion cannot be entered stepwise, but only by running into a breakpoint.
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7 Programming tools

This chapter describes tools that are available to help you assess the performance of
your code, identify potential performance problems, and locate the part of the code
where most of the execution time is spent.

7.1 Sampling Collector and Performance Analyzer
The Sampling Collector and the Performance Analyzer are a pair of tools that you
use to collect and analyze performance data for your application.

The Collector gathers performance data by sampling at regular time intervals and by
tracing function calls.

The performance information is gathered in so caled experiment files, which can
then be displayed with the analyzer GUI or the er_print command after the pro-
gram has finished.

7.1.1 The Collector
At first you have to compile your program with the
-9
option. Link the program as usua and then start the executable under the control of
the Sampling Collector

col l ect collect_options a.out
Every 10 milliseconds profile datawill be gathered and written in the experiment file
test. 1. er

The number will be automatically incremented on subsequent experiments. In fact
the experiment file is an entire directory with alot of information. One can manipu-
late these with the regular Unix commands, but it is recommended to use the

er_nv, er_rm er_cp

utilities to move, remove or copy these directories. This ensures for example that
time stamps are preserved

After
er_print test.1l.er

you can generate afirst ASCII report from the experiment with the command
functions

Further commands are explained after invoking help or through the man page of the
er_print command.

By selecting the options of the collect command, many different kinds of perform-

ance data can be gathered:

-p on | off | hi | Clock profiling ('hi' needs to be supported on the
l o system)

-Hon | off Heap tracing
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-mon | off MPI tracing

-h counteroO, O, Hardware Counters

counterl1, 0

-j on | off Java profiling

-Son | off | Periodic sampling (default interval: 1 sec)
seconds

-0 experinentfile Output file

-d directory Output directory

-g experinmentgroup |Output filegroup
Output file size limit [MB]

Follow descendant processes

-L size
-F on | off

Various hardware counters can be chosen for collecting. Typing the collect com-
mand without any parameters, will print out all the counters available for profiling.
Some of the events can only be gathered in register 0 and some only in register 1.
Favorite choices are given in the following table.

-h cycles,0,insts, 0 Cycle count, instruction count

The quotient is the CPI rate (clocks per
instruction) The optimum would be 0.25.

The Mhz rate of the CPU multiplied with the
instruction count divided by the cycle count gives

the MIPS rate.

Floating point additions and multiplications
The sum divided by theruntimein  sgives the
Mflop/srate

Cycle count, data trandlation look-aside buffer
(DTLB) misses

A high rate of DTLB misses indicates an
unpleasant memory access pattern of the program.
Large pages might help (Solaris 9)

-h fpadd, O, fpnul, 0

-h cycles,0,dtlbmO

-h cycles,0,ecstall,0

L2 cache stall cycles.

-h cycles,0,dcstall, 0

L1 plusL2 cache stall cycles

-h ecref, 0, ecm

L2 cache references and misses

-h decr,0,dcrmO

L1 cache read references and read misses

-h dcw, 0, dcwm O

L1 cache write references and write misses

7.1.2 The Performance Analyzer

For the standard case of just collecting clock profiling and printing out the most im-
portant information in text mode a simple shell script is available:

$ /usr/local _rwth/bin/sanple a.out
$ nore sanpl e. out RWTH|
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A program call tree with performance information can be displayed with the locally
developed utility

$ /usr/local _rwth/bin/er_view RWTH|

The full result of the analysis can be displayed graphically afterwards with the Per-
formance Analyzer GUI, which has been redesigned in the latest version.

$ anal yzer experinentfile.er

7.1.3 The Performance Tools Collector Library API

Sometimes it is convinient to group performance datain self defined samples, and to
collect performance data only of a specific part of the program.

For this purpose the libcollector library can easily be used.

In the following example Fortran program, performance data only of the subroutines
wor k1 and wor k2 is collected:

programtest coll ector

call collector_pause()

call preproc

call collector_resune()

call collector_sanple("start")
call workl

call collector_sanpl e("work1l")
call work2

call collector_sanpl e("work2")
call collector_term nate_expt()
cal |l postproc

end programtest coll ector

Thel i bf col | ect or library (C: |1 bcol | ect or) hasto be linked. And if this
program is started by

collect -S off a.out
performance data is only collected between the col | ect or _resune and the
col | ector _term nate_expt calls. No periodic sampling is done, but single
samples are recorded whenever col | ect or _sanpl e is caled. (The label is not

currently used). When the experiment file is evaluated, the filter mechanism can be
used to restrict the displayed data to the interesting program parts.

Seethel i bcol | ect or manual page for further information.

7.2 Frequency analysiswith t cov
For error detection and tuning it might be helpful to know, how often each statement
is executed. For testing a program it is important that all program branches are
passed (test coverage). For this purpose, the program must be compiled and linked
with the option
—xprofile=tcov

In the following program execution the frequencies of all statements recorded. The
values can be entered in modified program sources using the command
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$ tcov —a =50 —x a.out.profile \
[-p srcdir objdir] source files...

Statements which have never been executed are marked by “#”.

7.3 Run time analysis with gprof
With gprof, arun time profile on modulelevel canbe generatedThe programmust
be translatedand linked with the option —pg (Fortran)resp.—xpg (C). During the
execution a file namegimon.outis generated, which can be analyzed by

$ gprof program

With gprof it is easyto find out the numberof the calls of a programmodule,which
is a useful information for inlining.

NOTE: gprof assumeshatall calls of a moduleareequallyexpensivewhichis not
alwaystrue We recommendo usethe Callers-Calleesnfo in the PerformanceAns-
lyzer to gather this kind of information. It is much more reliable.

7.4Run time analysis of MPI programs

7.4.1Sampling Collector and Performance Analyzer

With MPI programsthe SamplingCollector (seechapter6.1) collectsrun time in-
formation for each MPI task, which can also be displayed for each task separately:

$ nprun -np n collect a.out
With a new option of the Sampling Collector MPI events can be traced as well
$ nprun -np n\
collect -mon -g experinent_group.erg a.out

togetherwith the ability to bundleexperimentfiles written by all MPI processeso
experiment groups and display them with the Analyzer

anal yzer experi nment _group

Runningcollect with a large numberof MPI processesthe amountof experiment
datamight becomeoverwhelming Startingthe MPI programwith alittle scriptwill
help:

nprun -np 4 run. ksh
with

#! / bi n/ ksh
# filename: run. ksh
if [[$MP_RANK < 2 ]]
t hen
collect -mon -g test.erg a.out
el se
a. out
f

Performancanformation will be collectedonly for the MPI processesvith rank O
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and 1.

7.4.2 Prism

The runtime analysis feature of Prism is no longer support. The usage of the analyzer
is recommended instead.

7.4.3 Vampir and Vampir Trace JIIg

Vampir/Vampirtrace is an MPI performance anaysis toolset sold by the company
Pallas. After linking the VampirTrace library to the MPI program, a trace file is
written during the program execution, which then can be displayed with the Vampir
graphical user interface.

Examplein C:
$ . vanpir.init
$ npcc -0 a.out ... *.c \

—L/usr/local _rwh/lib =l VT =l nmpi -1 nsl
$ nprun —-np 4 a.out
$ vanpir a.out.bvp

Example in Fortran:

$ . vanpir.init

$ npf90 -0 a.out ... *.f90 —R/usr/local _rwth/lib \
—L/usr/local _rwh/lib =l VT =l npi -1 nsl

$ nprun -np 4 a.out

$ vanpi r UNKNOMN. bvp

The functioning Vampirtrace library can be highly parametrized with a configuration
file. The name of thisfile has to be specified by the environment variable
VT_CONFI G

7.4.4 Jumpshot and the MPE Library

The Multi-Processing Environment (MPE) attempts to provide programmers with a
complete suite of performance anaysis tools for their MPI programs based on post
processing approach. These tools include a set of profiling libraries, a set of utility
programs, and a set of graphical visualization tools.

The most useful and widely used profiling libraries in MPE are the logging libraries.
Various logfile formats are supported, the most powerful one is SLOG. As the de-
fault format is the CLOG, the programmer must set an environment variable to over-
write the default format:

$ export MPE_LOG FORVAT=SLOG

After linking the libraries liblmpe.a (MPE logging interface) and libmpe.a (MPE
graphics, logging, and other extensions) and, in the case of a Fortran program, the
additional wrapper library libmpe_f2cmpi.a, the (binary) logfiles will be generated
during runtime. Visualize these logfiles with the jumpshot (version 3) utility.
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$ npcc -c foo.c
$ npcc -o foo foo.o \
-L/usr/local _rwh/lib -llnpe -Inpe -Inpi
$ export MPE_LOG FORVAT=SLOG
$ nprun -np 4 foo
$ junpshot foo. sl og

Example in Fortran:
$ nmpf90 -c foo.f90
$ npf90 -0 foo foo.o -L/usr/local _rwh/lib\
-l nmpe_f2cmpi -l 1 npe -1 npe -Inpi
$ export MPE_LOG FORVAT=SLOG
$ nprun -np 4 foo
$ j unpshot Unknown. sl og

NOTE: The trace file produced at the end of a Fortran program run is aways called
Unknown. bvp.
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8 Application software

8.1 Application software and program libraries
You will find the list of available application software and program libraries at http:
[lwww.rz.rwth-aachen.de/sw/

8.2 The Sun Performance Library
The Sun Performance Library is apart of the Sun One Studio Compiler Collection
environment and contains highly optimized and parallelized versions of the well
known standard libraries LAPACK version 3.0, BLAS, FFTPACK version 4 and
VFFTPACK Verson 2.1 from the field of linear algebra, Fast Fourier transforms
and solution of sparse linear systems of equations (Sparse Solver, SuperLU) (see
http://www.netlib.org). Please link your program with the options:

-xarch=vplus8b -xlic_lib=sunperf 32 bit addressing
-xarch=v9b -xlic_lib=sunperf 64 bit addressing

The performance of programs using the BLASI-library can be improved by the new
Fortran compiler option

- xknown_| i b=bl as
The corresponding routines will beinlined if possible.

The latest Performance Library contains new parallelized sparse BLAS routines for
matrix-matrix multiplication and a sparse triangular solver. Linpack routines are no
longer provided, it is stronly recommended to use the corresponding LAPACK rou-
tines.

Many of the contained routines have been parallelized using the shared memory
programming model. Compare the execution times! Example:

$ f90 BE@NNGA —nt -xlic_lib=sunperf
$ ptine a.out
$ ( export OVP_NUM THREADS=4; ptine a.out )

The number of Threads used by the parallel Performance Library can be determined
by the following call:

cal | USE_THREADS( n)

8.3TheSun S3L library

The S3L-Library offers to MPI programs access to distributed arrays similar to the
array descriptors, as they are used in the public domain packages ScaLAPACK and
PETSc. The S3L-Library offers many functions from the fields linear algebra, Fou-
rier transforms, etc. and further auxiliary functions (toolkit). Numerous kernel rou-
tines correspond to the ScaL APACK interfaces.

The Toolkit functions are useful for working with parallel arrays and processor
grids, aswell asfor paralel input or output. S3L arrays can be transformed into Sca-
LAPACK descriptors.
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8.4 Nag Numerical Libraries
The Nag Numerical Libraries provide a broad range of reliable and robust numerical
and statistical routines in areas such as optimization, PDEs, ODEs, FFTs, correlation
and regression, and multivariate methods, to name but a few.
They are available in three flavours:

1) The serial NAG Mark 19 FORTRAN-Library (32 bit addressing mode)

f90 -xarch=v8plusb -dalign ... \
-L/usr/local _rwh/lib -l1nagl9 \ -
xl'itc_lib=sunperf -I1F77

2) The shared memory version, which includes 231 routines that benefit from shared
memory parallelization (32- and 64-bit addressing modes) and has the identical
programming interface as the serial version

f90 -dalign -xarch=v8plusb ... \
-L/usr/local _rwth/lib -1nagsnp32 \ -
xI'ic_lib=sunperf -I1F77

f90 -dalign ... -xarch=v9b \

-L/usr/local _rwth/lib -1nagsnp64 \ -

xl'ic_lib=sunperf -I1F77

3) and the NAG Parallel Library Release 3.0, which contains 183 routines that have
been specifically developed for use on distributed memory systems (32 bit ad-
dressing mode) using the MPI library.
nmpf 90 -dalign -xarch=v8plusb ... \
-L/usr/local _rwh/lib -lInagnpi -1s3l
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9 Further information

9.1 Sun products

9.1.10n Sun’s web site

Sun Product Documentation (Overview)
(http://docs.sun.com)

Sun ONE Studio 8 Compiler Collection (Overview)
(http://docs.sun.com/coll/771.3?0=Forte+8)

Sun ONE Studio 8: Fortran User's Guide
(http://docs.sun.com/db/doc/817-0930?g=Forte+8)

Sun ONE Studio 8: C User's Guide
(http://docs.sun.com/db/doc/817-0924?2g=Forte+8)

Sun ONE Studio 8: C++ User's Guide
(http://docs.sun.com/db/doc/817-0926?2g=Forte+8)

Sun ONE Studio 8: Fortran Programming Guide
(http://docs.sun.com/db/doc/817-09297g=Forte+8)

Sun ONE Studio 8: Fortran Library Reference
(http://docs.sun.com/db/doc/817-09287?g=Forte+8)

Sun ONE Studio 8: OpenMP API User's Guide
(http://docs.sun.com/db/doc/817-0933?2g=Forte+8)

Prism 7.0 Software User's Guide
(http://docs.sun.com/db/doc/817-0088-10?q=Prism)

Prism 7.0 Software Reference Manual
(http://docs.sun.com/db/doc/817-0089-10?q=Prism)

Sun HPC ClusterTools 5 Software Documentation (Overview)
(http://docs.sun.com/coll/HPCCT5?0=Sun+MPl)

Sun HPC ClusterTools 5 Software User's Guide
(http://docs.sun.com/db/doc/817-0084-10?20=Sun+MPl)

Sun MPI 6.0 Software Programming and Reference Guide
(http://docs.sun.com/db/doc/817-0085-107g=Sun+MPl)

Sun HPC ClusterTools 5 Software Performance Guide
(http://docs.sun.com/db/doc/817-0090-10?2g=Sun+MPl)

Sun S3L 4.0 Software Programming Guide
(http://docs.sun.com/db/doc/817-0086-1070=Sun+S3L)

Sun S3L 4.0 Software Reference Manual
(http://docs.sun.com/db/doc/817-0087-1070=Sun+S3L)

9.1.20n local file systems

Forte Developer: Documentation (Forte, C, C++, dbx, OpenMP,
(/opt/SUNWSspro/docs/index.html)

HPC ClusterTools 5 Documentation (MPI, Prism, S3L)
(/opt/SUNWhpc/doc/index.html)
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9.2Third p

arty products
TotalView
(http://www.etnus.com

KAP Pro/Toolset
(http://support.rz.rwth-aachen.de/Manual K AI/KAP Pro Reference.pdf, http:
{ldeveloper.intel.com/software/products/kappro/

Vampir andVampirTrace
(http://support.rz.rwth-aachen.de/Manuals/Vampir/Vampir-userguide.pdf
http://support.rz.rwth-aachen.de/Manuals/Vampir/Vampirtrace-userguide.pdf
http://www.pallas.com

KCC
(http://support.rz.rwth-aachen.de/Manual K AlI/KCC docs/index.html, http://de-
veloper.intel.com/software/products/Kecc/

Foresys
(http://www.simulog.fj

9.3 Public domain software

mpich — Eine portierbare Implementierung von MPI
(http://www-unix.mcs.anl.gov/mpi/mpigh

PCL Performance Counter Library
(http://www.fz-juelich.de/zam/POL

9.4 Problems and inquiries

46

Helpdesk of the computer cenfareb interface)
(http://www.rz.rwth-aachen.de/computing/support/
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10 Miscellaneous

10.1 Other Useful commands

[ opt / SUNWpr o/ bi n/ dmake Parallel make (compare gmake)

[usr/bin/csplit Splits C programs

[ opt/ SUNWspr o/ bin/fsplit Splits Fortran programs

[usr/ccs/ bin/nm Prints the name list of object programs

[usr/bin/ldd Prints the dynamic dependencies of
executable programs

[ opt/ SUNWspr o/ bi n/lint More accurate syntax examination of C
programs

[ opt / SUNWspr o/ bi n/ cfl ow Prints the call hierarchy of a C program

[ opt / SUNWspr o/ bi n/ cxr ef Crossreference list of a C program

[ opt / SUNWspr o/ bi n/ ctrace Tracing of aC program

[ opt / SUNWSpr o/ bi n/ dunpst abs  |Analysis of an object program

[ usr/ bi n/ showr ev Prints the software status of the
machine

[usr/ bin/ptine Analysis of the /proc directory

[ usr/ bi n/ pst ack
[usr/bin/ptree
[ usr/ bi n/ pmap

[ usr/sbin/ sysdef system parameters

[ usr/sbin/prtconf system configuration

[usr/ pl at f or m SUNW Sun- diagnostic messages

Fire/ sbin/prtdi ag

[usr/sbin/psrinfo processor information

[ usr/ bi n/ pkgi nfo installed software packages

[ opt/ SUNWspr o/ bi n/ f pversion  |processor information

[usr/dt/bin/sdtprocess process list (compare top)

[ usr/ bin/sar system activity report

[usr/bin/truss log system calls

[ usr/ bin/sotruss log of shared library calls

ld.so. 1 Run time linker for dynamic objects

[ usr/ bi n/vmst at status of the virtual memory
organization

[ usr/bin/iostat |/O statistics

[ usr/ bi n/ busst at system bus performance counters

[ usr/ bin/ prstat Report active process statistics

get ti nmeof day Portable real time counter

#i ncl ude <sys/tine. h>
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11 Appendix: Debugging with TotalView on the Sun Fire
SMP-Cluster - Quick Reference Guide

This quick reference guide describes how to debug serial and parallel (OpenMP and MPI) programs
written in C, C++ or Fortran90 using the TotalView debbuger from Etnus Inc. on the RWTH Sun
Fire SMP-Cluster in avery condensed form. Hereisalist of the current software versions: Solaris 8
and 9, TotalView 6.1, Sun ONE Studio 8 compilers, Sun HPC ClusterTools 5.0, KAP/Pro Tool set
4.0.

For further information see www.etnus.com or
www.rz.rwth-aachen.de/computing/hpc/prog/debug/total view.

11.1 Debugging serial programs

11.1.1 Some general hintsfor using TotalView

» Click your middle mouse button to dive on things in order to get more information.

* Return (undive) by clicking on the () button, if available.

* You can change all values, which are highlighted.

» |If at any time the source pane of the process window shows disassembled machine code,

then the program is stopped in some internal routine. Select the first user routine in the
Stack Trace Panein order to see, where thisinternal routine has been evoked.

11.1.2 Compiling and Linking

Before debugging, compile your program with the —g option and without any optimisation. Y ou do
not need to use the —g option on your link command.

11.1.3 Starting TotalView

Y ou can debug your program
by either starting total view with your program as a parameter
totalview a.out [ -a options ]
or by starting your program first and than attaching totalview to it. In this case start
totalview
which first opensitsroot window . Select your program after pushing Unattached
Y ou can also analyse the core dump after your program crashed by
totalview a.out core
Startup Parameters (runtime arguments, environment variables, standard 10) can be set in the
Process > Start Parameters ... menu.
After starting your program TotalView open the Process Window . It consists of

» theSource Pane |, displaying your program’s source code,

» theStack Trace Pane , displaying the call stack.

» the Stack Frame Pane, displaying all the variables associated with the stack routine
selected
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the Thr eads Pane, showing the threads of the current process.
theActi on Poi nts Pane, listing all breakpoints, action points and evaluation points.

11.1.4 Setting a breakpoint

If the right function is already displayed in the Sour ce Pane, just click on a boxed line
number of an executable statement once to set a breakpoint. Clicking again will delete the
breakpoint.

Search the function with the Vi ew > Lookup Functi on command first.

If the function is in the current call stack, dive on it’'s name in the St ack Trace Pane
first.

Select Action Points > At Locati on andinput the function’s name.

11.1.5 Starting, Stopping and Restarting your program

Start your program by selecting Go on the icon bar and stop it by selecting Hal t .

Set a breakpoint and select Go to run the program until it reaches the line containing the
breakpoint.

Select aprogram line and click on Run To on theicon bar.

Step though a program line by line with the St ep and Next commands. St ep steps into
and Next jumps over function calls.

L eave the current function with the Qut command.

To restart aprogram, select G oup > Restart.

11.1.6 Printing a variable

The values of simple actual variables are displayed in the St ack Frame Pane of the
Process W ndow.

You may usetheVi ew > Lookup Vari abl e command.

When you dive (middle click) on a variable, a separate Vari abl e W ndow will be
opened.

Y ou can change the variabletypeinthe Var i abl e W ndow (type casting).

If you are displaying an array, the Sl i ce and Fi | t er fields lets you select which subset
of the array will be shown. (Examples: Slice: (3:5,1:10:2) , Filter: >30)

One and two-dimensional arrays or array slices can be graphicaly displayed by selecting
Tools > VisualizeintheVari abl e W ndow.

If you are displaying a structure, you can look at substructures by rediving or by using the
W ndow > Di ve Anewcommand or by selection of Di ve Anew after clicking on the
left mouse button.

11.1.7 Action Points: breakpoints, evaluation points, watchpoints

The program will stop, when it hits a breakpoint.

You can temporarily introduce some additional C or Fortran style program lines at an
evaluation point. After creating a breakpoint, right-click on the STOP sign and select
Properti es > Eval uat e totypeinyour new program lines.

Examples:
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an additional print statement: | printf ( “x = %f\n”,
(Fortran writeis not x/20)

accepted)

conditional breakpoint: if (i ==20) $stop
stop after every 20 $count 20
executions:

jump to program line 78: goto $78
Visualize an array $visualize a

» A watchpoint monitors avariable' s value. Whenever the content of this variable (memory
location) changes, the program stops. To set awatchpoint, dive on the variable to display its

Variable Window  and the select the Tools > Watchpoint command.
* Youcansave/ reload your actions points by selecting Action Point > Save All
resp. Load All

11.2 Debugging parallel programs

11.2.1 Some general hintsfor parallel debugging

If possible, make sure that your serial program runs fine first.

Debugging a parallel program is not always easy. Use as few MPI processes / OpenMP
threads as possible. Can you reproduce your problem with only one or two processes /
threads?

Get familiar with using TotalView by debugging a serial toy program first.

11.2.2 Debugging MPI programs

11.2.2.1 Starting TotalView
« You can start debugging your MPI program by
totalview mprun—-a ... -W —np nprocs a.out [options]

The root window will at first display the mprun process itself, in which you might not be
interested at all.
Add /opt/'SUNWhpc/lib and /usr/platform to the file path prefix list of dynamic
librariesin the File > Preferences > Dynamic Libraries menu and select select
Stop the group inthe File > Preferences > Parallel menu.
After clicking on the Go button in the process  window , mprun is started and all the
nprocs MPI user processes are started by mprun. They are automatically acquired by
totalview and displayed in the root window
The process window  will display your MPI root process.

* You can as well attach to a running MPI program. Find out the process id of the mprun
command first with the mpps —b command and then start totalview. After selecting
Filee > New Program, type mprun in the Executable field and its PID in the
Process ID field. If TotalView is running on a different node than mprun, enter the host
name in the Remote Host field aswell.

Y ou may switch to another MPI process by

» Clicking on another process in the root window

» Circulating through the attached processes with the P- or P+ buttons in the process window

Open another process window by clicking on one of the attached processes in the root window with

your right mouse button and selecting Dive Anew
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11.2.2.2Setting a breakpoint

Right clicking on a breakpoint symbol you can specify its properties. A breakpoint will stop the
whole process group (all MPI processes, default) or only one process. In case you want to
synchronize all processes at this location you have to change the breakpoint into a barrier by right
clicking on aline number and selecting Set Barrier in the pull down menu.

It isagood starting point to set and run into a barrier somewhere after the MPI initialisation phase.
Displaying and laminating the rank id after an initial call of MPI_Comm_rank revells, if the MPI
startup went well.

11.2.2.3Starting, Stopping and Restarting your program

You can perform stop, start, step, and examine single processes or groups of processes. Choose
Group (default) or Process inthefirst pulldown menu of the toolbar.

11.2.2.4Printing a variable

Y ou can examine the value of variables of al MPI processes by selecting View > Laminate in
avariable window.

Laminated scalar variables or one-dimensional arrays or array slices can be graphically visualized.
Therank id isinterpreted as an additional dimension.

11.2.2.5Message Queues

You can look into outstanding non-blocking message passing operations with the Tools >
Message Queue Window or the Tools > Message Queue Graph

11.2.3Debugging OpenMP programs

11.2.3.1Some general hints for debugging OpenMP programs

In the case you are using Fortran, does the serial program compiled with f95 —stackvar —xO3 ...
(Sun) run correctly? Check the compiler’s messages in the *.Ist files after adding the —XlistMP
option!

Typical OpenMP coding errors cause data races which can be detected with the Assure tool from
KAl/Intel. It isvery unlikely that you will detect a data race in a debugging session.

11.2.3.2Compiling

The Sun compilers —xopenmp and —xautopar compiler switches automatically evoke high
optimisation (-xO3). Since Studio 8 you can use the —xopenmp=noopt -g switches for C
and Fortran (but not for C++). As an alternative you can use the Guide OpenMP-compilers of
KAI's KAP/Pro Toolset in combination with Total View:
Compile your code with

guidef90|guidec|guidec++ -WG,-cmpo=i [-WGkeepcpp] —g ...

11.2.3.3Starting TotalView
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Start debugging your OpenM P program after specifying the number of threads you want to use
OVP_NUM THREADS=nt hr eads tot al vi ew a. out

The parallel regions of an OpenMP program are outlined into separate subroutines. Shared

variables are passed as call parameters to the outlined routine and private variables are defined

locally. A parallel region cannot be entered stepwise, but only by running into a breakpoint.

11.2.3.4 Setting a breakpoint

Right clicking on a breakpoint symbol you can specify its properties. A breakpoint will stop the
whole process (group) by default or only the thread for which the breakpoint is defined. In case
you want to synchronize all processes at this location you have to change the breakpoint into a
barrier by right clicking on aline number and selecting Set Bar ri er inthe pull down menu.

11.2.3.5 Starting, Stopping and Restarting your program

Y ou can perform stop, start, step, and examine single threads or the whole process (group). Choose
G oup (default) or Pr ocess or Thr ead in thefirst pulldown menu of the toolbar.

11.2.3.6 Printing a variable

You can examine the value of variables of all threads by selecting Vi ew > Lam nate in a
variable window.

Laminated scalar variables or one-dimensional arrays or array slices can be graphically visualized.
Thethread id isinterpreted as an additional dimension.
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